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Introduction

The Import Tool for FactoryTalk™ allows you to convert a FactoryTalk application into an BLUE Open Studio (BOS)
project, and then deploy it on any platform supported by BOS. This tool was designed to import tags, screens, alarm
configuration, and communication settings. After converting applications, you can also edit and enhance them,
leveraging any native feature of BLUE Open Studio.

This document describes all interfaces supported by the Import Tool for FactoryTalk™, as well as its limitations.
Interfaces that are not explicitly described in this manual may not be supported. When necessary, you can use the
standard Integrated Development Environment (IDE) from BLUE Open Studio to manually configure any interface
that is not automatically converted by this tool.

This import wizard is sold as an add-on for BLUE Open Studio, and it requires a license to be enabled. For more
information, consult your software vendor.

Also, if you are running BLUE Open Studio on a Windows operating system that has User Account Control (UAC)
enabled, then you may have problems using this import wizard. Close the application, and then run it again as an
administrator (i.e., right-click the BLUE Open Studio program icon, and then click Run as administrator on the
shortcut menu).

REMARKS:

*» This document describes the known limitations for this tool by the time that this document was written.
If you identify additional limitations, please report them to your software vendor.

» If the Import Wizard finds any unexpected property when importing a screen, the whole screen will not
be converted at all. Therefore, if you experience this behavior, please share the exported files from the
screens that were not converted with your software vendor, so we can study the feasibility to address
the limitation in a timely manner.
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How to convert projects from FactoryTalk™ ME/SE to BLUE Open Studio

Export tags from FactoryTalk project

1.

R

Open FactoryTalk project;
In FactoryTalk View Studio, from the Tools menu, select Tag Import and Export Wizard;
Select Export FactoryTalk View tag database to CSV file;

Follow the instructions in the wizard;

Export graphic displays from FactoryTalk project

1.

w0 DN

Open FactoryTalk project;
In the Explorer windows, right-click the Displays editor or the Global Objects editor;
Select Import and Export;

Follow the instructions in the wizard;

Export alarm files from FactoryTalk ME project: ALARMS ARE NOT CURRENTLY SUPPORTED BY THE
IMPORT WIZARD WHEN USING FactoryTalk ME.

Export alarm files from FactoryTalk SE project

1.

o 0 o DN

Open FactoryTalk project;

In FactoryTalk View Studio, from the Tools menu, select Tag Import and Export Wizard,
Select Export FactoryTalk View tag database to CSV file;

Select Site Edition on Project Type;

Follow the instructions in the wizard;

Importing files from FactoryTalk project on BLUE Open Studio

Open Import Wizard:

Home > Import Wizard > Import Tool for FactoryTalk™
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Import FactoryTalk Converter Wizard
Options
(®) Do not impart duplicate items () Replace duplicates with imported items
Tag {.csv):
Browse...
[ Juse prefix:

Screen(s) (.xml):

Browse...

Alarm (.csv | .xml):
Browse...

FactoryTalk Application Folder:

Browse...

Drivers
|:|Impcurt Drivers: | Configuration

Options
Do not import duplicate items: When this option is selected, the following items are not imported in case
there is already an equivalent in the current project:

o Tags Database (tags with the same name will not be imported)

o Screens (screens with the same name will not be imported)

Importing Tag
Click Browse to select the .csv file exported from FactoryTalk application that you intend to import are
stored.

Use prefix
Select this option to specify a prefix that will be prepended to the names of the imported tags. It is useful to
differentiate the imported tags from the tags created manually.

Importing Screens
Click Browse to select the .xml file(s) exported from FactoryTalk application that you intend to import are
stored. This option import the graphical screens (including their objects and animations) to BLUE Open Studio.
Note: Check the User Manual to know which objects are supported.

Importing Alarm configuration
Click Browse to select the .csv (SE Projects) file exported from FactoryTalk application that you intend to
import are stored. Alarm configuration from FactoryTalk ME (*.xml files) are not supported by the Import Wizard.

FactoryTalk Application Folder
Click Browse to select the directory where the FactoryTalk application are stored.
Note: If don’t specify the application folder, images and parameters files will not be imported.

Importing Drivers
Check this option to import the driver configuration to BLUE Open Studio.
Note: Tags will be automatically replaced.
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Configuration...
Figure 2. Devices configuration list

Devices

Remove

Devices
Shows the list of configured devices.

Add...
Figure 3. Device configuration

Device MName: Driver:

ABCIP

o Device Name: Specify device name exactly as it is in the FactoryTalk application.
e Driver: Select communication driver.

e Station: Type the device station of the PLC. The station syntax depends on the option selected on
the Driver combo-box. Please consult the respective driver manual for more details.

Edit...
Edit device from the list of configured devices.

Remove
Remove device from the List of configured devices.
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Importing Tag
After configuring the settings in this dialog, click Next.

Tag Mame Size Type Description
M| cCustomPropertyPlaceHolder 0 Boolean Used by FactoryTalk Converter to import parameters.

Check Unchedk Filter... Clear Filter Import only filtered tags

Status Legend

This tag cannot be imported because it already exists in the current project M Error

database. B Tag will be imported
M Tag can be imported

Database size
Current: | 8526 Importing: | O Replacing: | 0

The fields and settings that are common for all data Source Types include the following:

e Grid: Displays the list of tags found on the data source.
o checkbox: Check to import the tag from the data source to the Tags Database of the current project.
o TagName: Name of the tag
o Size: Array size of the tag
o Type: Data type of the tag (Boolean, Integer, Real, String or Class:<ClassName>)
o Description: Description of the tag
e Check button: Click to select/import all tags in the grid
e Uncheck button: Click to uncheck all tags in the grid

¢ Filter button: Click to filter the tags. The Filter dialog will display, allowing you to specify a mask for each
column in the grid. Wild cards (* and ?) can be used to filter data.

e Clear Filter button: Click to reset the filter.

¢ Import Filtered Tags Only checkbox: Check this option to import only the tags that are visible in the grid
(filtered).

e Status box: Displays a message describing the status of the tag currently selected in the grid. This
information is especially useful to indicate why a tag cannot be imported.

¢ Legend box: Describes the meaning of the colors that represent tag status:
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o (Red) Error:Tag cannot be imported because it is not supported by BOS. See the Status box for a
detailed description of the error.

o (Blue) Tag will be imported:Tag will be imported after you click the Finish button.
o (Gray) Tag can be imported:Tag can be imported but it has not been checked.
e Database size box: Displays summary information regarding the current Import Wizard:
o Current: Indicates the number of tags configured in the Project Tags database of the current project
o Importing: Indicates the number of tags selected to be imported

o Replacing: Indicates the number of tags configured in the Project Tags database of the current
project that will be replaced by an imported tag with the same name.

After selecting the tags to import, click the Finish button, or click Cancel to abort the operation.
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Graphical Interface — Displays and Objects

This chapter describes the features supported when converting screens from FactoryTalk™ ME/SE to BLUE Open
Studio, as well as the limitations.

Object

Property

Status

Remarks

Display Settings (ME)

Replace

S

Display

Type OnTop

Cannot Be Replaced

Display Number

Security Code

Title Bar

Disable Initial Input Focus

Maximum Tag Update Rate

Use Current Size

»w | 2| 2| 0w | 2 Z2| 2| n

Size Specify Size in

Pixels

(7]

X

Position
Y

Background Color > Color

Background Color

Display Settings (SE)

Replace

Display

Type Overlay

OnTop

Allow Multiple Running Copies

Cache After Displaying

Title Bar

System Menu

Minimize Button

Maximize Button

Size to Main Windows at Runtime

Show Last Acquired Value

Z 2 |l n| 2 2 nuolZ 0ol n unu n
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Object Property Status Remarks

Maximum Tag Update Rate N

Use Current Size S

Size Specify Size in s

Pixels

Allow Display to be

Resize Resized

When Resized

4

Use Current
Position

(7]

Position X

Y

Security Code

Background Color > Color

Background Color

Track Screen for Navigation

Navigation History Screen Name

Text

Back Color

Fore Color

Size to fit Always checked.

Word wrap

»w | 2 rn o onuo 2 2 nu| no 2 u|on

Size

MiddleLeft, Center and MiddleRight
only.

-

Text (ME/SE) Alignment
General

Insert Variable > s
Numeric > Tag

Insert Variable >
Numeric > Literal S
number

Insert Variable >
Numeric > Number S
of digits

Insert Variable > S
Numeric > Decimal
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Object Property Status Remarks

places

Insert Variable >
Numeric > Fill left N
with

Insert Variable > s
String > Tag

Insert Variable >
String > Literal S
string

Insert Variable >
String > Fixed
number of
characters

Insert Variable >
String > Right-most
characters in string

are displayed

Insert Variable >

String > Show *

character if string is N

longer than field
width

Insert Variable > s
Time/Date

Back style

Size > Height

Size > Width

Common Position > Top

Position > Left

Z Ol n | n u

Other

Image file only be imported if
specified FactoryTalk application
path on import wizard.

(7]

Image

Image color

Image (ME/SE) General
Image back color

Image blink

Image back style

»w | | 2 2 Z2

Common Size > Height
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Object Property Status Remarks

Size > Width S

Position > Top

S
Position > Left S
N

Other

Inset will be imported as Sunken on
BLUE Open Studio.

Border style L

RaisedlInset will be imported as

Etched on BLUE Open Studio.

Border width S

Back style S

General Pattern style N

Border uses back
color

(7]

Panel (ME/SE) Pattern color

Back color

Border color Only exports with line border.

Blink

Size > Height

Size > Width

Common Position > Top

Position > Left

Other

Line style None, Solid and Dash only.

Back style

Pattern style

General Fore color

Arc (ME/SE) Back color

Pattern color

Line width

Size > Height

Common

v unul n | 2 0o on | 2 unu rrfz2 o 0o »nu nu 2 ro»no 2

Size > Width
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Object Property Status Remarks

»

Position > Top

Position > Left

Other

Line style None, Solid and Dash only.

Back style

Pattern style

General Fore color

Back color

Ellipse (ME/SE) Pattern color

Line width

Size > Height

Size > Width

Common Position > Top

Position > Left

Other

Line style None, Solid and Dash only.

Back style

Pattern style

General Fore color

Back color

Freehand (ME/SE) Pattern color

Line width

Size > Height

Size > Width

Common Position > Top

Position > Left

Other

Line (ME/SE) Line style None, Solid and Dash only.

General

»w | rrRz oo oo 0o v 2 0 0 2 0| rz2 oOonu u nu unu 2 u0u unu| 2 u -2 o

Back style
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Object Property Status Remarks

»

Fore color

Back color

Line width

Size > Height

Size > Width

Common Position > Top

Position > Left

Other

Line style None, Solid and Dash only.

Back style

Pattern style

General Fore color

Back color

Pattern color

Polygon (ME/SE)
Line width

Size > Height

Size > Width

Common Position > Top

Position > Left

Other

Line style None, Solid and Dash only.

Back style

Pattern style

General Fore color

Polyline (ME/SE) Back color

Pattern color

Line width

Size > Height

Common

v unul n | 2 0ol | 2 »nurz o 0o nu unul unu 2 0 unu 2 u\ rZ2 o nu u unu nu ou

Size > Width
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Object Property Status Remarks

»

Position > Top

Position > Left

Other

Line style None, Solid and Dash only.

Back style

Pattern style

General Fore color

Back color

Rectangle (ME/SE) Pattern color

Line width

Size > Height

Size > Width

Common Position > Top

Position > Left

Other

Line style None, Solid and Dash only.

Back style

Pattern style

General Fore color

Back color

Rounded Rectangle

(ME/SE) Pattern color

Line width

Size > Height

Size > Width

Common Position > Top

Position > Left

Other

Wedge (ME/SE) Line style None, Solid and Dash only.

General

»w | rrz oo oo o nu 2 0 v 2 0| rz22 oonu u nu unu 2 u0u unu| 2 u rr "2 o

Back style
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Object Property Status Remarks
Pattern style N
Fore color S
Back color S
Pattern color N
Line width S
Size > Height S
Size > Width S
Common Position > Top S
Position > Left S
Other N
General > Style N
Capture cursor N
Highlight when
Other object has focus N
Tab Index N
Action > Set tag to 1 L Confirm Action not supported.
Action > Set tag to 0 L Confirm Action not supported.
Action > Toggle tag s
value
Action ;
Action > Set tag to 1
Button (SE) on press and to 0 on S
release
Action > Set tag to 0
on press and to 1 on S
release
Confirm Action and Repeat rate
(secs) not supported.
Run Command L
(Check the list of commands
supported)
General > Back style S
Up General > Pattern
Appearanc N
e style
General > Fore color S
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Object

Property

Status

Remarks

General > Back
color

S

General > Pattern
color

Caption > Font

Caption > Size

Caption>B

Caption> |

Caption> U

»w | | »nu | nul u

Caption > Insert
Variable > Numeric
>Tag

Caption > Insert
Variable > Numeric
> Literal number

Caption > Insert
Variable > Numeric
> Number of digits

Caption > Insert
Variable > Numeric
> Decimal places

Caption > Insert
Variable > Numeric
> Fill left with

Caption > Insert
Variable > String >
Tag

Caption > Insert
Variable > String >
Literal string

Caption > Insert
Variable > String >
Fixed number of
characters

Caption > Insert
Variable > String >
Right-most
characters in string
are displayed

Caption > Insert
Variable > String >
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Object

Property

Status

Remarks

Show * character if
string is longer than
field width

Caption > Insert
Variable >
Time/Date

Image settings > No
image

Image settings >
Use image reference

Image settings >
Import file

Image settings >
Scale image

Down Appearance

Disabled Appearance

Size > Height

Size > Width

Common Position > Top

Position > Left

Other

Z Ol n| n | 2 2

Momentary Push Button
(ME/SE)

Appearance >
Border style

Inset will be imported as Sunken on
BLUE Open Studio.

RaisedInset will be imported as
Etched on BLUE Open Studio.

Appearance > Back
style

Appearance >
Shape

Rectangle only.

General Appearance >

Border width

Appearance >
Border Uses Back
Color

Appearance >
Highlight color

Button settings >
Button action
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Object Property Status Remarks
Button settings > s
Hold time
Touch margins > N
Horizontal margin
Touch margins > N
Vertical margin
Other > audio S
Select state S
General > Value S
General > Back s
color
General > Border L Only exports with line border.
color
General > Blink N
General > Pattern N
Style
General > Pattern N
color
Caption > Font S
Caption > Caption s
color
States
Caption > Caption N
back color
Caption > Caption N
blink
Caption > Word s
wrap
Caption > Size S
Caption > Alignment S
Caption > Insert
Variable > Numeric S
> Tag
Caption > Insert
Variable > Numeric S
> Literal number
Caption > Insert S

Variable > Numeric
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Object

Property

Status

Remarks

> Number of digits

Caption > Insert
Variable > Numeric
> Decimal places

Caption > Insert
Variable > Numeric
> Fill left with

Caption > Insert
Variable > String >
Tag

Caption > Insert
Variable > String >
Literal string

Caption > Insert
Variable > String >
Fixed number of
characters

Caption > Insert
Variable > String >
Right-most
characters in string
are displayed

Caption > Insert
Variable > String >
Show * character if

string is longer than
field width

Caption > Insert
Variable >
Time/Date

Caption>B

Caption> |

Caption> U

Caption > Caption
backstyle

Image settings

Common

Size > Height

Size > Width

Position > Top

Position > Left

»w @ unu nl n |l Z2
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Object Property Status Remarks
Other N
Connectio Value S
ns Indicator S
Inset will be imported as Sunken on
Appearance > . BLUE Open Studio.
Border style RaisedlInset will be imported as
Etched on BLUE Open Studio.
Appearance > Back s
style
Appearance >
Shape L Rectangle only.
Appearance > s
Border width
Appearance >
General Border Uses Back S
Color
Appearance > N
Highlight color
State settings >
Next state based on L Current State only.
Maintained Push Button
(ME/SE) Touch margins > N
Horizontal margin
Touch margins > N
Vertical margin
Other > audio S
Select state S
General > Value S
General > Back s
color
General > Border L Only exports with line border.
States color
General > Blink N
General > Pattern N
Style
General > Pattern N

color
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Object Property Status Remarks
Caption > Font S
Caption > Caption s
color
Caption > Caption N
back color
Caption > Caption N
blink
Caption > Word s
wrap
Caption > Size S
Caption > Alignment S
Caption > Insert
Variable > Numeric S
>Tag
Caption > Insert
Variable > Numeric S
> Literal number
Caption > Insert
Variable > Numeric S
> Number of digits
Caption > Insert
Variable > Numeric S
> Decimal places
Caption > Insert
Variable > Numeric N
> Fill left with
Caption > Insert
Variable > String > S
Tag
Caption > Insert
Variable > String > S
Literal string
Caption > Insert
Variable > String > s
Fixed number of
characters
Caption > Insert
Variable > String >
Right-most N

characters in string
are displayed
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Object Property Status Remarks
Caption > Insert
Variable > String >
Show * character if N
string is longer than
field width
Caption > Insert
Variable > S
Time/Date
Caption>B S
Caption> | S
Caption> U S
Caption > Caption N
backstyle
Image settings N
Size > Height S
Size > Width S
Common Position > Top S
Position > Left S
Other N
Connectio Value S
ns Indicator S
Inset will be imported as Sunken on
Appearance > . BLUE Open Studio.
Border style Raisedlnset will be imported as
Etched on BLUE Open Studio.
Appearance > Back s
style
Appearance >
Latched Push Button L Rectangle only.
(ME/SE) General Shape
Appearance > s
Border width
Appearance >
Border Uses Back S
Color
Appearance > N

Highlight color
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Object Property Status Remarks
Button settings > s
Latch reset type
Touch margins > N
Horizontal margin
Touch margins > N
Vertical margin
Other > audio S
Select state S
General > Value S
General > Back s
color
General > Border L Only exports with line border.
color
General > Blink N
General > Pattern N
Style
General > Pattern N
color
Caption > Font S
Caption > Caption s
color
States
Caption > Caption N
back color
Caption > Caption N
blink
Caption > Word s
wrap
Caption > Size S
Caption > Alignment S
Caption > Insert
Variable > Numeric S
> Tag
Caption > Insert
Variable > Numeric S
> Literal number
Caption > Insert S

Variable > Numeric
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Object

Property

Status

Remarks

> Number of digits

Caption > Insert
Variable > Numeric
> Decimal places

Caption > Insert
Variable > Numeric
> Fill left with

Caption > Insert
Variable > String >
Tag

Caption > Insert
Variable > String >
Literal string

Caption > Insert
Variable > String >
Fixed number of
characters

Caption > Insert
Variable > String >
Right-most
characters in string
are displayed

Caption > Insert
Variable > String >
Show * character if

string is longer than
field width

Caption > Insert
Variable >
Time/Date

Caption>B

Caption> |

Caption> U

Caption > Caption
backstyle

Image settings

Common

Size > Height

Size > Width

Position > Top

Position > Left

»w @ unu nl n |l Z2
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Object Property Status Remarks
Other N
Value S
Connectio Indicator S
ns
Handshake S
Inset will be imported as Sunken on
Appearance > . BLUE Open Studio.
Border style RaisedlInset will be imported as
Etched on BLUE Open Studio.
Appearance > Back s
style
Appearance >
Shape L Rectangle only.
Appearance > s
Border width
Appearance >
Border Uses Back S
General Color
Appearance > N
Highlight color
State settings >
Number of states S
Multistate Push Button
(ME/SE) .
State settings >
Next state based on L Current State only.
Touch margins > N
Horizontal margin
Touch margins > N
Vertical margin
Other > audio S
Select state S
General > Value S
General > Back s
color
States
General > Border L Only exports with line border.
color
General > Blink N
General > Pattern N
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Object Property Status Remarks
Style
General > Pattern N
color
Caption > Font S
Caption > Caption s
color
Caption > Caption N
back color
Caption > Caption N
blink
Caption > Word s
wrap
Caption > Size S
Caption > Alignment S
Caption > Insert
Variable > Numeric S
>Tag
Caption > Insert
Variable > Numeric S
> Literal number
Caption > Insert
Variable > Numeric S
> Number of digits
Caption > Insert
Variable > Numeric S
> Decimal places
Caption > Insert
Variable > Numeric N
> Fill left with
Caption > Insert
Variable > String > S
Tag
Caption > Insert
Variable > String > S
Literal string
Caption > Insert
Variable > String > s
Fixed number of
characters
Caption > Insert N

Variable > String >
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Object

Property

Status

Remarks

Right-most
characters in string
are displayed

Caption > Insert
Variable > String >
Show * character if

string is longer than
field width

Caption > Insert
Variable >
Time/Date

Caption>B

Caption> |

Caption> U

Caption > Caption
backstyle

Image settings

Timing

Auto Repeat setting

Common

Size > Height

Size > Width

Position > Top

Position > Left

Other

Connectio
ns

Value

Indicator

»w @ unu | 2 0ol o no| n | 2 2

Interlocked Push Button
(ME/SE)

General

Appearance >
Border style

Inset will be imported as Sunken on

BLUE Open Studio.

RaisedInset will be imported as
Etched on BLUE Open Studio.

Appearance > Back
style

Appearance >
Shape

Rectangle only.

Appearance >
Border width

Appearance >
Border Uses Back
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Object Property Status Remarks
Color
Appearance > N
Highlight color
Button Value S
Touch margins > N
Horizontal margin
Touch margins > N
Vertical margin
Other > audio S
It is imported first state only, BLUE
Select state L Open Studio works with only one
state.
General > Value S
General > Back s
color
General > Border L Only exports with line border.
color
General > Blink N
General > Pattern N
Style
General > Pattern N
color
Caption > Font S
States
Caption > Caption s
color
Caption > Caption N
back color
Caption > Caption N
blink
Caption > Word s
wrap
Caption > Size S
Caption > Alignment S
Caption > Insert
Variable > Numeric S
> Tag
S

Caption > Insert
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Object

Property

Status

Remarks

Variable > Numeric
> Literal number

Caption > Insert
Variable > Numeric
> Number of digits

Caption > Insert
Variable > Numeric
> Decimal places

Caption > Insert
Variable > Numeric
> Fill left with

Caption > Insert
Variable > String >
Tag

Caption > Insert
Variable > String >
Literal string

Caption > Insert
Variable > String >
Fixed number of
characters

Caption > Insert
Variable > String >
Right-most
characters in string
are displayed

Caption > Insert
Variable > String >
Show * character if

string is longer than
field width

Caption > Insert
Variable >
Time/Date

Caption>B

Caption> |

Caption> U

Caption > Caption
backstyle

Image settings

Common

Size > Height
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Object Property Status Remarks
Size > Width S
Position > Top S
Position > Left S
Other N
Connectio Value s
ns
Inset will be imported as Sunken on
Appearance > . BLUE Open Studio.
Border style Raisedinset will be imported as
Etched on BLUE Open Studio.
Appearance > Back s
style
Appearance >
Shape L Rectangle only.
Appearance > s
Border width
Appearance > N
Pattern style
Appearance >
Border Uses Back S
Color
Ramp Button (ME/SE) General Appearance > Back S
color
Appearance > s
Border color
Appearance > N
Pattern color
Appearance > N
Highlight color
Appearance > Blink N
Button settings >
Use variable S
lower/upper Limit
Button settings >
Use variable ramp S
value
Button settings > s

Ramp up
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Object Property Status Remarks
Button settings > s
Ramp down
Button settings > s
Upper Limit
Button settings > s
R |
amp value
Touch margins > N
Horizontal margin
Touch margins > N
Vertical margin
Other > audio S
It is imported first state only, BLUE
Select state L Open Studio works with only one
state.
General > Value S
General > Back s
color
General > Border L Only exports with line border.
color
General > Blink N
General > Pattern N
Style
General > Pattern N
color
States .
Caption > Font S
Caption > Caption s
color
Caption > Caption N
back color
Caption > Caption N
blink
Caption > Word s
wrap
Caption > Size S
Caption > Alignment S
Caption > Insert S

Variable > Numeric
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Object

Property

Status

Remarks

>Tag

Caption > Insert
Variable > Numeric
> Literal number

Caption > Insert
Variable > Numeric
> Number of digits

Caption > Insert
Variable > Numeric
> Decimal places

Caption > Insert
Variable > Numeric
> Fill left with

Caption > Insert
Variable > String >
Tag

Caption > Insert
Variable > String >
Literal string

Caption > Insert
Variable > String >
Fixed number of
characters

Caption > Insert
Variable > String >
Right-most
characters in string
are displayed

Caption > Insert
Variable > String >
Show * character if

string is longer than
field width

Caption > Insert
Variable >
Time/Date

Caption>B

Caption> |

Caption> U

Caption > Caption
backstyle

Image settings
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Object

Property

Status

Remarks

Common

Size > Height

Size > Width

Position > Top

Position > Left

Other

Connectio
ns

Value

Ramp

Limit

»w @ unul n | 2 u0o|n | n

Numeric Display (ME)

General

Appearance >
Border Style

Inset will be imported as Sunken on
BLUE Open Studio.

RaisedlInset will be imported as
Etched on BLUE Open Studio.

Appearance > Back
style

Appearance >
Border width

Appearance >
Pattern style

Appearance >
Border Uses Back
Color

Appearance > Back
color

Appearance >
Border color

Only exports with line border.

Appearance >
Pattern color

Appearance > Fore
color

Appearance > Blink

Text > Font

Text > Size

Text>B

Text> 1/

»w @ unu nl n |2

Page 35/82




Import Wizard Tool for FactoryTalk™ ME/SE — Rev. C

Object Property Status Remarks
Text>U S
Text > Alignment S
Value settings > N
Number of digits
Value settings > Fill N
left with
Value settings > s
Decimal places
Size > Height S
Size > Width S
Common Position > Top S
Position > Left S
Other N
Connectio Value S
ns Polarity s
Expression S
Show Digit N
Grouping
Field Length S
Decimal Places N
Format > Decimal S
Format > s
General Hexadecimal
Numeric Display (SE) Format > Octal N
Format > Binary S
Format > Floating
. N
Point
Overflow N
Leading Character N
Justification S
Size > Height S
Common
Size > Width S
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Object Property Status Remarks
Position > Top S
Position > Left S
Other N

Inset will be imported as Sunken on

Appearance > BLUE Open Studio.

Border style L
y Raisedinset will be imported as
Etched on BLUE Open Studio.
Appearance > Back s
style
Appearance >
Shape L Rectangle only.
Appearance > s
Border width
Appearance > N
Pattern style
Appearance >
Border Uses Back S
Color
Appearance > Back s
color

Numeric Input Enable General Appearance >
(ME) pp L

Border color Only exports with line border.

Appearance >
Pattern color

Appearance >
Highlight color

Appearance > Blink N

Touch margins >

Horizontal margin N
Touch margins > N
Vertical margin

Other > Audio N
Other > Key N

navigation
Other > Take focus N

on press
Label Caption > Font S
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Object

Property

Status

Remarks

Caption > Caption
color

S

Caption > Caption
back color

Caption > Caption
blink

Caption > Word
wrap

Caption > Size

Caption > Alignment

Caption > Insert
Variable > Numeric
> Tag

Caption > Insert
Variable > Numeric
> Literal number

Caption > Insert
Variable > Numeric
> Number of digits

Caption > Insert
Variable > Numeric
> Decimal places

Caption > Insert
Variable > Numeric
> Fill left with

Caption > Insert
Variable > String >
Tag

Caption > Insert
Variable > String >
Literal string

Caption > Insert
Variable > String >
Fixed number of
characters

Caption > Insert
Variable > String >
Right-most
characters in string
are displayed

Caption > Insert
Variable > String >

Page 38/82




Import Wizard Tool for FactoryTalk™ ME/SE — Rev. C

Object Property Status Remarks
Show * character if
string is longer than
field width
Caption > Insert
Variable > S
Time/Date
Caption > B S
Caption> | S
Caption> U S
Caption > Caption N
backstyle
I i S Image file only be imported if
mag? Setlings L specified FactoryTalk application
mage path on import wizard.
Image settings > N
Image color
Image settings > N
Image blink
Image settings > L Always enabled
Image scaled
Image settings > s
Image back style
Image settings > N
Alignment
Pop-up settings > N
Numeric pop-up
Min/max range and
ramp settings > S
Minimum value
Min/max range and
ramp settings > S
Maximum value
Numeric ]
Min/max range and
ramp settings > N
Ramp value
Min/max range and
ramp settings > Use s
variable
minimum/maximum
Decimal point N

settings > Decimal
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Object Property Status Remarks

point

Decimal point
settings > Fixed N
position output

Decimal point
settings > Digits N
after decimal

Timing and
handshake settings

4

Timing

Size > Height

Size > Width

Common Position > Top

Position > Left

Other

Value

Optional Exp

Connectio Enter

ns Enter Handshake

Minimum

Maximum

Tag

Tab index

Default data

Field length

Decimal places

»w | 2| 2| 2| 2 0o 0| »n | 2| 2 2 0| Z2 0o »no nuo ou

Format > Decimal

Numeric Input (SE) General
Format > s
Hexadecimal

Format > Octal N

Format > Binary S

Format > Floating
Point

Overflow N
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Object Property Status Remarks
Justification N
Leading Character N
Display On-screen N
Keyboard
Security N
Continuosly update N
Discard input and
resume updating N
when focus is lost
Confirm Numeric
N
Entry
Size > Height S
Size > Width S
Common Position > Top S
Position > Left S
Other N
Value S
Connectio Minimum s
ns
Maximum S
Navigation Button (SE) N Object not supported.
Numeric Input Cursor .
Point (ME) N Object not supported.
Inset will be imported as Sunken on
Appearance > . BLUE Open Studio.
Border Style RaisedlInset will be imported as
Etched on BLUE Open Studio.
Appearance > Back s
style
String Display (ME) General Appearance > S
Border width
Appearance > N
Pattern style
Appearance >
Border Uses Back S
Color
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Object Property Status Remarks
Appearance > Back s
color
Appearance > L Only exports with line border.
Border color
Appearance > N
Pattern color
Appearance > Fore N
color
Appearance > Blink N
Text > Font S
Text > Size S
Text >B S
Text >/ S
Text>U S
Text > Alignment S
Value settings > N
Number of digits
Value settings > Fill N
left with
Value settings > s
Decimal places
Size > Height S
Size > Width S
Common Position > Top S
Position > Left S
Other N
Connectio Value s
ns
Expression S
Dimensions > Width S
String Display (SE) General Dimensions >
. S
Height
Character > Offset N
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Object Property Status Remarks
Character > s
Justification
Size > Height S
Size > Width S
Common Position > Top S
Position > Left S
Other N
Inset will be imported as Sunken on
Appearance > . BLUE Open Studio.
Border style Raisedinset will be imported as
Etched on BLUE Open Studio.
Appearance > Back s
style
Appearance >
Shape L Rectangle only.
Appearance > s
Border width
Appearance > N
Pattern style
Appearance >
Border Uses Back S
Color
String Input Enable (ME) General
Appearance > Back s
color
Appearance > L Only exports with line border
Border color ’
Appearance > N
Pattern color
Appearance > N
Highlight color
Appearance > Blink N
Touch margins > N
Horizontal margin
Touch margins > N
Vertical margin
Other > Audio N
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Object Property Status Remarks
Other > Key N
navigation
Other > Take focus N
on press
Caption > Font S
Caption > Caption s
color
Caption > Caption N
back color
Caption > Caption N
blink
Caption > Word s
wrap
Caption > Size S
Caption > Alignment S
Caption > Insert
Variable > Numeric S
> Tag
Caption > Insert
Variable > Numeric S
SLi
Label Literal number
Caption > Insert
Variable > Numeric S
> Number of digits
Caption > Insert
Variable > Numeric S
> Decimal places
Caption > Insert
Variable > Numeric N
> Fill left with
Caption > Insert
Variable > String > S
Tag
Caption > Insert
Variable > String > S
Literal string
Caption > Insert
Variable > String > s

Fixed number of
characters
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Object Property Status Remarks

Caption > Insert
Variable > String >
Right-most N
characters in string
are displayed

Caption > Insert
Variable > String >

Show * character if N
string is longer than
field width
Caption > Insert
Variable > S
Time/Date
Caption>B S
Caption> | S
Caption> U S
Caption > Caption N
backstyle
. Image file only be imported if
Imagelz settings > L specified FactoryTalk application
mage . .
path on import wizard.
Image settings > N
Image color
Image settings > N
Image blink
Image settings > L Always enabled
Image scaled
Image settings > s
Image back style
Image settings > N
Alignment
Pop-up settings > N
String pop-up
Pop-up settings > N
Fill character
String Pop-up settings >
Number of input N
characters
Pop-up settings > N

Fill character
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Object Property Status Remarks
Pop-up settings > N
Mask scratchpad
- Timing and
Timing handshake settings N
Size > Height S
Size > Width S
Common Position > Top S
Position > Left S
Other N
Value S
Connectio Enter N
ns
Enter Handshake N
Tag S
Tab index N
Default data N
Dimensions > Width S
Dimensions > s
Height
Justification > Left S
Justification > s
Center
General
Justification > Right S
String Input (SE)
Display On-screen N
Keyboard
Security N
Continuously N
Discard input and
resume updating N
when focus is lost
Confirm String N
Entry
Size > Height S
Common
Size > Width S
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Object Property Status Remarks
Position > Top S
Position > Left S
Other N
Inset will be imported as Sunken on
Appearance > . BLUE Open Studio.
Border style Raisedinset will be imported as
Etched on BLUE Open Studio.
Appearance > Back s
style
Appearance >
Shape L Rectangle only.
Appearance > s
Border width
Appearance > N
Pattern style
Appearance >
Border Uses Back S
Color
Appearance > Back s
color
Goto DI?I\TE{ Button General Appearance > s
Border color
Appearance > N
Pattern color
Appearance > N
Highlight color
Appearance > Blink N
Display settings > s
Display
Display settings > s
Parameter file
Display settings > s
Parameter list
Display settings > N
Display position
Display settings >
Use Variable S

Display Position
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Object Property Status Remarks
Touch margins > N
Horizontal margin
Touch margins > N

Vertical margin
Other > Audio S
Caption > Font S
Caption > Caption s
color
Caption > Caption N
back color
Caption > Caption N
blink
Caption > Word s
wrap
Caption > Size S
Caption > Alignment S
Caption > Insert
Variable > Numeric S
>Tag
Caption > Insert
Variable > Numeric S
Label > Literal number
Caption > Insert
Variable > Numeric S
> Number of digits
Caption > Insert
Variable > Numeric S
> Decimal places
Caption > Insert
Variable > Numeric N
> Fill left with
Caption > Insert
Variable > String > S
Tag
Caption > Insert
Variable > String > S
Literal string
Caption > Insert s

Variable > String >
Fixed number of
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Object

Property

Status

Remarks

characters

Caption > Insert
Variable > String >
Right-most
characters in string
are displayed

Caption > Insert
Variable > String >
Show * character if

string is longer than
field width

Caption > Insert
Variable >
Time/Date

Caption>B

Caption> |

Caption> U

Caption > Caption
backstyle

Image settings >
Image

Image file only be imported if
specified FactoryTalk application

path on import wizard.

Image settings >
Image color

Image settings >
Image blink

Image settings >
Image scaled

Always enabled

Image settings >
Image back style

Image settings >
Alignment

Common

Size > Height

Size > Width

Position > Top

Position > Left

Other

Connectio

Display Name

»w | 2 0wl nul nu| on
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Object Property Status Remarks
ns Top Position N
Left Position N
Inset will be imported as Sunken on
Appearance > . BLUE Open Studio.
Border style Raisedinset will be imported as
Etched on BLUE Open Studio.
Appearance > Back s
style
Appearance >
Shape L Rectangle only.
Appearance > s
Border width
Appearance > N
Pattern style
Appearance >
Border Uses Back S
Color
General
Appearance > Back s
color
Appearance > L Only exports with line border.
Return to Display (ME) Border color y exp )
Appearance > N
Pattern color
Appearance > N
Highlight color
Appearance > Blink N
Touch margins > N
Horizontal margin
Touch margins > N
Vertical margin
Other > Audio S
Caption > Font S
Caption > Caption s
color
Label
Caption > Caption N
back color
N

Caption > Caption
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Object

Property

Status

Remarks

blink

Caption > Word
wrap

Caption > Size

Caption > Alignment

Caption > Insert
Variable > Numeric
> Tag

Caption > Insert
Variable > Numeric
> Literal number

Caption > Insert
Variable > Numeric
> Number of digits

Caption > Insert
Variable > Numeric
> Decimal places

Caption > Insert
Variable > Numeric
> Fill left with

Caption > Insert
Variable > String >
Tag

Caption > Insert
Variable > String >
Literal string

Caption > Insert
Variable > String >
Fixed number of
characters

Caption > Insert
Variable > String >
Right-most
characters in string
are displayed

Caption > Insert
Variable > String >
Show * character if

string is longer than
field width

Caption > Insert
Variable >

Time/Date
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Object Property Status Remarks
Caption>B S
Caption> | S
Caption> U S
Caption > Caption N
backstyle
Imade settinas > Image file only be imported if
9 Image 9 L specified FactoryTalk application
9 path on import wizard.
Image settings > N
Image color
Image settings > N
Image blink
Image settings > L Always enabled
Image scaled
Image settings > s
Image back style
Image settings > N
Alignment
Size > Height S
Size > Width S
Common Position > Top S
Position > Left S
Other N
Inset will be imported as Sunken on
Appearance > . BLUE Open Studio.
Border style RaisedInset will be imported as
Etched on BLUE Open Studio.
Appearance > Back s
style
Close Display (ME) General Appearance > L Rectangle only_
Shape
Appearance > s
Border width
Appearance > N
Pattern style
Appearance > S
Border Uses Back
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Object Property Status Remarks
Color
Appearance > Back s
color
Appearance > s
Border color
Appearance > N
Pattern color
Appearance > N
Highlight color
Appearance > Blink N
Value > Write on N
close
Touch margins > N
Horizontal margin
Touch margins > N
Vertical margin
Other > Audio S
Caption > Font S
Caption > Caption s
color
Caption > Caption N
back color
Caption > Caption N
blink
Caption > Word s
wrap
Label Caption > Size S
Caption > Alignment S
Caption > Insert
Variable > Numeric S
> Tag
Caption > Insert
Variable > Numeric S
> Literal number
Caption > Insert
Variable > Numeric S

> Number of digits
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Object

Property

Status

Remarks

Caption > Insert
Variable > Numeric
> Decimal places

Caption > Insert
Variable > Numeric
> Fill left with

Caption > Insert
Variable > String >
Tag

Caption > Insert
Variable > String >
Literal string

Caption > Insert
Variable > String >
Fixed number of
characters

Caption > Insert
Variable > String >
Right-most
characters in string
are displayed

Caption > Insert
Variable > String >
Show * character if

string is longer than
field width

Caption > Insert
Variable >
Time/Date

Caption>B

Caption> |

Caption> U

Caption > Caption
backstyle

Image settings >
Image

Image file only be imported if
specified FactoryTalk application

path on import wizard.

Image settings >
Image color

Image settings >
Image blink

Image settings >

Always enabled
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Object Property Status Remarks
Image scaled
Image settings > s
Image back style
Image settings > N
Alignment
Size > Height S
Size > Width S
Common Position > Top S
Position > Left S
Other N
Connectio Value s
ns
List Display Selector N Object not supported.
(ME)
Inset will be imported as Sunken on
Appearance > . BLUE Open Studio.
Border style RaisedlInset will be imported as
Etched on BLUE Open Studio.
Appearance > Back s
style
Appearance >
Shape L Rectangle only.
General Appearance > s
Border width
Appearance >
Multistate Indicator Border Uses Back S
(ME/SE) Color
State settings > s
Number of states
Stat_e settings > L Value only.
Trigger type
Select state S
General > Value S
States General > Back s
color
General > Border 1
color L Only exports with line border.
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Object Property Status Remarks
General > Blink N
General > Pattern N
Style
General > Pattern N
color
Caption > Font S
Caption > Caption s
color
Caption > Caption N
back color
Caption > Caption N
blink
Caption > Word s
wrap
Caption > Size S
Caption > Alignment S
Caption > Insert
Variable > Numeric S
>Tag
Caption > Insert
Variable > Numeric S
> Literal number
Caption > Insert
Variable > Numeric S
> Number of digits
Caption > Insert
Variable > Numeric S
> Decimal places
Caption > Insert
Variable > Numeric N
> Fill left with
Caption > Insert
Variable > String > S
Tag
Caption > Insert
Variable > String > S
Literal string
Caption > Insert s

Variable > String >
Fixed number of
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Object Property Status Remarks
characters
Caption > Insert
Variable > String >
Right-most N
characters in string
are displayed
Caption > Insert
Variable > String >
Show * character if N
string is longer than
field width
Caption > Insert
Variable > S
Time/Date
Caption>B S
Caption> | S
Caption> U S
Caption > Caption N
backstyle
Image settings N
Size > Height S
Size > Width S
Common Position > Top S
Position > Left S
Other N
Connectio Indicator S
ns
Symbol (ME/SE) N Object not supported.
List Indicator (ME/SE) N Object not supported.
Inset will be imported as Sunken on
Appearance > . BLUE Open Studio.
Border Style RaisedlInset will be imported as
Etched on BLUE Open Studio.
Bar Graph (ME/SE) General
Appearance > Back s
style
Appearance > s

Border width
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Object

Property

Status

Remarks

Appearance > Fill
style

S

Appearance >
Border Uses Back
Color

Appearance > Back
color

Appearance >
Border color

Only exports with line border.

Appearance > Fill
color

»

Bar graph
settings

Minimum value

Maximum value

Fill direction

Thresholds

Common

Size > Height

Size > Width

Position > Top

Position > Left

Other

Z ool ol n| 2 nu nou

Connectio
ns

Value

»

Gauge (ME/SE)

General

Object is imported as Gauge BLUE
Open Studio’s symbol.

Display

Value settings >
Minimum value

Value settings >
Maximum value

Legend settings

Threshold settings

Common

Size > Height

Size > Width

Position > Top

Position > Left

»w | un| 2| 2 2| 2
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Object Property Status Remarks
Other N
Connectio Value s
ns
Border style L None only.
Line style L None, Solid and Dash only.
Back style L Transparent only.
Border width N
Line width S
Appearanc
e Border uses back N
color
Back color N
Border color N
Scale (ME/SE) Fore color S
Blink N
Tick direction S
Scale C .
Setup Major ticks S
Minor ticks S
Size > Height S
Size > Width S
Common Position > Top S
Position > Left S
Other N
Pause Trend Button N Object not supported.
(ME)
Next Pen Button (ME) N Object not supported.
Trend (ME/SE) N Object not supported.
Inset will be imported as Sunken on
Key Buttons (ME/SE) - Appearance > L BLUE Open Studio.
Eﬁﬂ:pﬁgi’j_ne?; E\;‘;?Iré General Border style RaisedInset will be imported as
Right, Move Down, Move Etched on BLUE Open Studio.
up, Page Down, Page up Appearance > Back s
style
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Object Property Status Remarks
Appearance >
Shape L Rectangle only.
Appearance > s
Border width
Appearance > N
Pattern style
Appearance >
Border Uses Back S
Color
Appearance > Back s
color
Appearance > L Only exports with line border
Border color :
Appearance > N
Pattern color
Appearance > N
Highlight color
Appearance > Blink N
Touch margins > N
Horizontal margin
Touch margins > N
Vertical margin
Other > Audio S
Other > Send press
to > Object With S
Focus
Other > Send press N
to > Linked Object
Caption > Font S
Caption > Caption s
color
Caption > Caption N
back color
Label
Caption > Caption N
blink
Caption > Word s
wrap
Caption > Size S
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Object

Property

Status

Remarks

Caption > Alignment

S

Caption > Insert
Variable > Numeric
> Tag

Caption > Insert
Variable > Numeric
> Literal number

Caption > Insert
Variable > Numeric
> Number of digits

Caption > Insert
Variable > Numeric
> Decimal places

Caption > Insert
Variable > Numeric
> Fill left with

Caption > Insert
Variable > String >
Tag

Caption > Insert
Variable > String >
Literal string

Caption > Insert
Variable > String >
Fixed number of
characters

Caption > Insert
Variable > String >
Right-most
characters in string
are displayed

Caption > Insert
Variable > String >
Show * character if

string is longer than
field width

Caption > Insert
Variable >
Time/Date

Caption>B

Caption> |

Caption> U
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Object Property Status Remarks
Caption > Caption N
backstyle
. Image file only be imported if
Imagelz settings > L specified FactoryTalk application
mage . .
path on import wizard.
Image settings > N
Image color
Image settings > N
Image blink
Image settings > L Always enabled
Image scaled
Image settings > s
Image back style
Image settings > N
Alignment
Size > Height S
Size > Width S
Common Position > Top S
Position > Left S
Other N
Value S
Optional Exp N
Connectio Enter N
ns Enter Handshake N
Minimum S
Maximum S
Control List Selector .
(ME/SE) N Object not supported.
Pilot Control List .
Selector (ME/SE) N Object not supported.
Local Message Display N Object not supported. (Future
(ME/SE) Release)
. Object not supported. (Future
Login Button (ME) N Release)
Logout Button (ME) N

Object not supported. (Future
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Object Property Status Remarks
Release)
Object not supported. (Future
Password Button (ME) N Release)
Macro Button (ME) N Object not supported.
Inset will be imported as Sunken on
Appearance > . BLUE Open Studio.
Border style Raisedlnset will be imported as
Etched on BLUE Open Studio.
Appearance > Back s
style
Appearance >
Shape L Rectangle only.
Appearance > s
Border width
Appearance > N
Pattern style
Appearance >
Border Uses Back S
Color
General
Appearance > Back s
color
Print Button (ME) Appearance > L Only exports with line border.
Border color
Appearance > N
Pattern color
Appearance > N
Highlight color
Appearance > Blink N
Touch margins > N
Horizontal margin
Touch margins > N
Vertical margin
Other > Audio S
Caption > Font S
Caption > Caption s
Label color
Caption > Caption N

back color
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Object

Property

Status

Remarks

Caption > Caption
blink

N

Caption > Word
wrap

Caption > Size

Caption > Alignment

Caption > Insert
Variable > Numeric
>Tag

Caption > Insert
Variable > Numeric
> Literal number

Caption > Insert
Variable > Numeric
> Number of digits

Caption > Insert
Variable > Numeric
> Decimal places

Caption > Insert
Variable > Numeric
> Fill left with

Caption > Insert
Variable > String >
Tag

Caption > Insert
Variable > String >
Literal string

Caption > Insert
Variable > String >
Fixed number of
characters

Caption > Insert
Variable > String >
Right-most
characters in string
are displayed

Caption > Insert
Variable > String >
Show * character if

string is longer than
field width

Caption > Insert

Variable >
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Object Property Status Remarks
Time/Date
Caption>B S
Caption> | S
Caption> U S
Caption > Caption N
backstyle
. Image file only be imported if
Imangjgtténgs > L specified FactoryTalk application
9 path on import wizard.
Image settings > N
Image color
Image settings > N
Image blink
Image settings > L Always enabled
Image scaled
Image settings > s
Image back style
Image settings > N
Alignment
Size > Height S
Size > Width S
Common Position > Top S
Position > Left S
Other N
Inset will be imported as Sunken on
Appearance > . BLUE Open Studio.
Border style Raisedinset will be imported as
Etched on BLUE Open Studio.
Appearance > Back s
style
Shutdown Button (ME) General
Appearance >
Shape L Rectangle only.
Appearance > s
Border width
Appearance > N

Pattern style

Page 65/82




Import Wizard Tool for FactoryTalk™ ME/SE — Rev. C

Object Property Status Remarks
Appearance >
Border Uses Back S
Color
Appearance > Back s
color
Appearance > L Only exports with line border
Border color .
Appearance > N
Pattern color
Appearance > N
Highlight color
Appearance > Blink N
Touch margins > N
Horizontal margin
Touch margins > N
Vertical margin
Other > Audio S
Caption > Font S
Caption > Caption s
color
Caption > Caption N
back color
Caption > Caption N
blink
Caption > Word s
wrap
Caption > Size S
Label
Caption > Alignment S
Caption > Insert
Variable > Numeric S
> Tag
Caption > Insert
Variable > Numeric S
> Literal number
Caption > Insert
Variable > Numeric S
> Number of digits
S

Caption > Insert
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Object

Property

Status

Remarks

Variable > Numeric
> Decimal places

Caption > Insert
Variable > Numeric
> Fill left with

Caption > Insert
Variable > String >
Tag

Caption > Insert
Variable > String >
Literal string

Caption > Insert
Variable > String >
Fixed number of
characters

Caption > Insert
Variable > String >
Right-most
characters in string
are displayed

Caption > Insert
Variable > String >
Show * character if

string is longer than
field width

Caption > Insert
Variable >
Time/Date

Caption>B

Caption> |

Caption> U

Caption > Caption
backstyle

Image settings >
Image

Image file only be imported if
specified FactoryTalk application

path on import wizard.

Image settings >
Image color

Image settings >
Image blink

Image settings >
Image scaled

Always enabled
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Object

Property

Status

Remarks

Image settings >
Image back style

S

Image settings >
Alignment

Common

Size > Height

Size > Width

Position > Top

Position > Left

Other

Z »n|ln |l nu|on

Time Date Display
(ME/SE)

General

Appearance >
Border style

Inset will be imported as Sunken on
BLUE Open Studio.

RaisedInset will be imported as
Etched on BLUE Open Studio.

Appearance > Back
style

Appearance >
Border width

Appearance >
Pattern style

Appearance >
Border Uses Back
Color

Appearance > Back
color

Appearance >
Border color

Appearance >
Pattern color

Appearance >
Highlight color

Appearance > Blink

Text > Font

Text > Size

Text>B

Text> 1/

»w | | »n| un| 2
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Object Property Status Remarks

Text>U S

Text > Alignment S

Time and s

date format

Size > Height S

Size > Width S

Common Position > Top S

Position > Left S

Other N
ActiveX Control (ME/SE) N Object not supported.
Recip(el\::’IIEL/l;EB)utton N Object not supported.
Recipe(ll:’nlltzl/ssg;alector N Object not supported.
ReCir():nFél;ésE-)rable N Object not supported.
Recipe (SE) N Object not supported.
Language Switch Button N Object not supported.

(ME)
Symbol Factory (ME/SE) S Supported.

S:Supported; N:Not Supported; L:Supported with Limitations
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Graphical Interface — Animations

This chapter describes the features supported when converting screens object animations from FactoryTalk™
ME/SE to BLUE Open Studio, as well as the limitations.

Category Type Status Remarks
Expression S
Tags S
Visibility (ME/SE)
Expression... S
Expression true state L Always visible.
Expression S
Tags S
Expression... S
Value S
Line N
Color (ME/SE) Fill S
Shaded not supported.
Fill Style L
FactoryTalk don’t exports Gradient.
Blink L The second color is always the object.
BLUE Open Studio accepts only slow and
Blink rate (Seconds) L fast, (values >= 1) = fast and (values < 1) =
slow
Expression S
Tags S
Expression... S
Expre’ssmp range > Use Export only value min and max at the
. . tag’s min and max L
Horizontal/Vertical roperty values moment.
Position (ME/SE) property
Expression range > Use s
constant
Expression range > N
Read from tags
Vertical offset (Pixels) S
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Category Type Status Remarks
Expression S
Tags S
Expression... S
Exrt)arg’sssir:?nr::g;;l;lse L Export only value min and max at the
property values moment.
Height / Width (ME/SE) Expression range > Use S
constant
Expression range > N
Read from tags
Vertical change s
(Percent)
Anchor S
Expression S
Tags S
Expression... S
Expression range > Use Export only value min and max at the
tag’s min and max L moment
property values )
Fill (ME/SE) Expression range > Use s
constant
Expression range > N
Read from tags
Fill (Percent) S
Fill Direction S
Inside Only L Checked only.
Expression S
Tags S
Expression... S
. S _
Rotation (ME/SE) Exrt);g’sss I,:?nr::g;agse L Export only value min and max at the
property values moment.
Expression range > Use s
constant
N

Expression range >
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Category Type Status Remarks
Read from tags
Rotation (Degrees) S
Center of rotation L LeftTop, LeftBottom, Center, RightTop and

RightBottom only.

Note: Rotation support only Line, Polygon and Polyline

Expression S
Tags S
Expression... S
Expre’ssm_n range > Use Export only value min and max at the
tag’s min and max L moment
Horizontal/Vertical Slider property values )
(ME/SE)
Expression range > Use s
constant
Expression range > N
Read from tags
Horizontal/Vertical s
offset (Pixels)
Touch (ME/SE) N Not supported.
OLE Verb (ME/SE) N Not supported.

S:Supported; N:Not Supported; L:Supported with Limitations
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COMMANDS (SE)

This chapter describes commands supported when converting applications from FactoryTalk™ SE to BLUE Open
Studio, as well as the limitations.

Commands not supported will be imported with the following syntax:

//[COMMAND_NOT_SUPPORTED: <Command_Name>"

For example:

/ICOMMAND_NOT_SUPPORTED: AppAbort”

Therefore, you can use the Global Find tool to look for the /COMMAND_NOT_SUPPORTED text and manually edit
each instance that is not automatically supported.

Category

Type

Command

Status

Remarks

System

Tag and
Database

S

Ramp

Set

Toggle

External
Applications

AppAbort

AppActive

AppStart

DDEEXxecute

OpenRSLogix5000

Multimedia

Beep

PlayWave

Framework

Define

Help

Pause

PrintDisplay

ScreenPrint

SendKeys

Undefine

Languages

Language

2 | 2| Z2 | Z2| 2| 2| 2| Z2| Z2|Z2| 2| 2| | Z2| 2 0| n u
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Category

Type

Command

Status

Remarks

Security

Login

Logout

Password

Activity Log

Remark

Graphics

Navigation

Abort

»w | @ u nul un

Display

File, IX, /Y, /H, /W, IP and /T

only.

DisplayNavigationHistor
y

4

DisplayNextScreen

DisplayPreviousScreen

NextWindow

PrevWindow

PullForward

PushBack

SetFocus

Cache

FlushCache

2 | 2| Z2| 0| Z2| 2 2| 2

Object
Methods

Invoke

4

Cursor
Movement

NextPosition

Position

PrevPosition

Recipe
Management

Download

DownloadAll

RecipeRestore

RecipeSave

Upload

UploadAll

Alarms

Acknowledge

AcknowledgeAll

AlarmAcceptEdits

2 | 2|\ »nw | Z2 | Z2| 2|\ 2|\ 2| 2| 2| 2| Z
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Category

Type Command

Status

Remarks

AlarmEvent

N

AlarmLogNewfFile

AlarmLogOff

AlarmLogOn

AlarmLogRemark

AlarmLogSendToOdbc

AlarmOff

AlarmOn

AlarmPrintOff

AlarmPrintOn

HandshakeOff

HandshakeOn

Identify

Silence

SilenceAll

SuppressOff

SuppressOffAll

SuppressOn

Data Log

DataLogChangeRate

DataLogMergeToPrimary

DataLogNewFile

DatalLogOff

DataLogOn

DataLogRenameFile

DataLogSnapshot

DataLogSwitchBack

Logic and Control

DerivedOff

Derived Tags
DerivedOn

DisplayClient DisplayClientClose

2 | Z2 | Z2 | Z2| 2| 2| 2| 2|  Z2|Z2| 2| 2| 2| 2| 2| Z2| 2| 2| 2| 2| 2| Z2| 2| 2| 2| 2| Z2)|Z
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Category Type Command Status Remarks
DisplayClientOpen N
EventOff N
Events
EventOn N
Flow Control If S
Client Keys Key N
Macro N

S:Supported; N:Not Supported; L:Supported with Limitations

Page 76/82




Import Wizard Tool for FactoryTalk™ ME/SE — Rev. C

EXPRESSIONS (ME/SE)

This chapter describes expressions supported when converting applications from FactoryTalk™ ME/SE to BLUE
Open Studio, as well as the limitations.

Category

Expression

Status

Remarks

If

Then

Else

Logical

AND or &&

ORor ||

NOT

Relational

<orlLT

<=orLE

>or GT

>=or GE

<> or NE

==or EQ

Arithmetic

+ or Plus

- or Minus

| or Divide

* or Multiply

% or Modulus

** or Exponent

Bitwise

& or AND

| or OR

A or XOR

>> or Right Shift

<< or Left Shift

~ or Complement

»w | o 0o 0o oo oo 0o nuo 0o 0o o ol nu nu nuo oo v n nu nu unu ou
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Category

Expression

Status

Remarks

Functions

Math

Arccos

»

Arccosd

Arcsin

Arcsind

Arctan

Arctand

Cos

Cosd

Log

Log10

Sin

Sind

Sqrt

Tan

Tand

Security

CurrentUserHasCode

CurrentUserName

Language

Current Language

Tags

»w | Z2| 2| 2| ol 0o 0o o »nuo 0o o nuolno nu »nu nu nu ou

Supported.

S:Supported; N:Not Supported; L:Supported with Limitations
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This chapter describes the alarm types supported when converting applications from FactoryTalk™ SE to BLUE
Open Studio, as well as the limitations. Alarms configured on FactoryTalk™ ME are not converted to BLUE Open

Studio.
Category Condition Status Remarks
Alarm (ME) N Not supported.
Alarm States > Alarm Type > s
On
Alarm States > Alarm Type > s
Off
Alarm States > Alarm Type > N
Any Change
Alarm States > Alarm Type > N
Changes to On
Alarm States > Alarm Type > N
Changes to Off
Alarm States > Alarm Label S
Digital Alarm States > Severity N
Alarm Alarm States > In Alarm N
Messages > System Defaults
Alarm (SE) Alarm States > In Alarm N
Messages > User Defaults
Alarm States > In Alarm s
Messages > Custom Message
Alarm States > In Alarm N
Messages > File
Alarm States > In Alarm s
Messages > Printer
Alarm Messages N
Advanced N
Accept 4 threshold only.
Analog Alarm Thresholds > Select L Increasing: Will be
Alarm Threshold imported 4 threshold that

contain most severity, case
severities are equal will be
imported the element with
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Category Condition Status Remarks
most value.
Decreasing: Will be
imported 4 threshold that
contain most severity, case
severities are equal will be
imported the element with
less value.
Alarm Thresholds > s
Threshold
Alarm Thresholds > Alarm
S
Label
Alarm Thresholds > Severity S
Alarm Thresholds > In Alarm N
Messages > System Defaults
Alarm Thresholds > In Alarm N
Messages > User Defaults
Alarm Thresholds > In Alarm s
Messages > Custom Message
Alarm Thresholds > In Alarm N
Messages > File
Alarm Thresholds > In Alarm s
Messages > Printer
Alarm Messages N
Advanced N

S:Supported; N:Not Supported; L:Supported with Limitations
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Communication Interface

When importing applications from FactoryTalk SE/ME projects, the communication interface can be converted
using the following drivers from BLUE Open Studio:

Driver Name Manufacturer Device Interface

Protocol
ABCIP Allen-Bradley ControlLogix,MicroLogix Ethernet Ethernet/IP (CIP)
ABTCP Allen-Bradley PLC2, PLC5, SLC500 Ethernet DF1
ABKE Allen-Bradley PLC2, PLC5, SLC500 Serial DF1
ABENI Allen-Bradley PLC2, PLC5, SLC500 Ethernet to Serial DF1

Look at the chapter “How to convert projects from FactoryTalk™ ME/SE to BLUE Open Studio” for instructions on
how to link BLUE Open Studio drivers to Device Names on the FactoryTalk™ ME/SE application.
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TIPS AND TRICKS

Startup Screen

Checking startup screen on FactoryTalk View

1.
2.

Open FactoryTalk project;
In the Explorer windows, right-click the Startup editor or the Global Objects editor;
The statup dialog opens;

Initial graphic field contains the startup screen.

Specifying the startup screen on BLUE Open Studio

1.

On the Project tab of the ribbon, in the Settings group, click Viewer. The Project Settings dialog is
displayed with the Viewer tab selected.

In the Startup screen box, type main.scr. When you run the project, it will automatically display the main
screen (or whichever screen you specify) first. You can specify a screen before you create it, but if the
screen has been created, then you can also select it from the list.

Click OK.
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